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1 Introduction

The AS7030B Evaluation Kit allows evaluation of all functions on the AS7030B Biosensor and test
them in various applications.

The initial Evaluation Kit works with USB connection to the PC and comes with a GUI, which enables
the user to change AS7030B register settings, see measurement results and many more.

The SDK (Software Development Kit) currently contains algorithms for HRM, HRV and BP and is
supplied with the Evaluation Kit. The compiled firmware can be flashed onto the STM32 ARM Cortex-
M4 low power MCU.

1.1 Kit Content

Figure 1:
Evaluation Hardware Board
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For full flexibility, the vital signs sensor (AS7030B), an accelerometer (LIS2DH12) and three
electrodes are located on the break out board, which can be used in any application and re-connected
to the main board via FPC cable once broken off. There is also the option to attach external
electrodes. If you are using an optional Wristband evaluation kit, AS7038 wristband needs to be
connected to the Wristband PicoBlade connector K500 on Mainboard and sensor part of the kit need
to be separated from Mainboard.

Any signals important for development are accessible for probing at pin headers.
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1.2 Ordering Information
Ordering Code Description
AS7030B-EVALKIT Evaluation Kit for AS7030B
AS7030B-WRISTBAND Wristband to connect to AS7030B Evalkit
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2 Getting Started

The client software latest version is available for download at https://ams.com/as7030B#tab/tools or
the software is possible to find on the USB stick as a part of the evaluation kit. To install, start the
installer executable and follow the instructions as shown in Figure 2 (left to right top to bottom).

Figure 2:
AS7030B Vital Signs Sensor Installation

[ Setup - AS703x Vital Signs Sensor [l Setup - AS703x Vital Signs Sensor

Select Additional Tasks

License Agreement
Which additional tasks should be performed?

Please read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this Select the additional tasks you would like Setup to perform while installing AS703x Vital
agreement before continuing with the installation. Signs Sensor, then dick Next.

DISCLATMER - ams AG ~ [] ‘Remove settings'
Additional shortuts:

IMPORTANT - PLEASE READ CAREFULLY BEFCRE COPYING,
[] Create a desktop shortout
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[ Setup - AS703x Vital Signs Sensor

Ready to Install - -
Setup is now ready to begin installing AS703x Vital Signs Sensor on your Completlng the 95703)( Vital Slg“S
computer, Sensor Setup Wizard

Setup has finished installing AS703x Vital Signs Sensor on your
computer, The application may be launched by selecting the
installed shortcuts,

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Additional tasks:

‘Remove settings' Click Finish to exit Setup.

Launch AS703x Vital Signs Sensor

< Back Install Cancel Finish
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For Windows OS versions prior to Windows® 10, the STSW-STM32102 virtual COM port driver needs
to be installed as well. The driver can be found in the <drivers\STM32_vcp_driver> folder contained
within the client software installation path. To install it, go to your OS version directory (Win7 or Win8,
OS versions prior to Windows® 7 are compatible with the Windows® 7), then:

1. Double click on dpinst_x86.exe if you are running a 32-bits OS version
2, Double click on dpinst_amd64.exe if you are running a 64-bits OS version
3. Follow the instructions

For updating the FW on the evaluation board over USB, the DfuSe driver from STMicroelectronics has
to be installed. This is available in the <drivers\DFU> folder contained within the client software
installation path. To install it, go to your OS version directory (Win7, Win8 or Win8.1), then:

1. Go to [x86] directory or [x64] directory based on your OS version:

2 Double click on dpinst_x86.exe if you are running a 32-bits OS version

3. Double click on dpinst_amd64.exe if you are running a 64-bits OS version
4 Follow the instructions

0 Information

In some cases, it can be necessary that the driver needs to be installed even on a Windows 10
system. In this case chose the driver installer from the Win 8.1 folder and install.
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3 Hardware Description

3.1 Hardware Architecture

Figure 3:
Evaluation Hardware Board — Top View
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Figure 4.
Evaluation Hardware Board — Bottom View
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3.2 Power Supply

The AS7030B Eval Kit is supplied by the USB connection. In order to avoid a direct connection from
the electrodes to the power grid, an IEC 60601-1 compliant RECOM DCDC converter (R0.25S-0505/H
or R0.25S-0505/HP) is assembled on the board as well as isolator ICs for all signals passing to the
sensor board. This means that there is no galvanic connection between the sensor board and the
power grid.
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4 AS7030B Overview

The AS7030B is a photocurrent and voltage sensor capable of taking PPG, ECG, proximity and skin
temperature/resistivity measurements. It integrates an optical front end, ECG amplifier, electrical
analog front end and light to frequency (LTF) converter. It features a built-in sampling sequencer, 128-
byte FIFO, a 14-bit SAR ADC, four GPIO pins and an 12C interface.

4.1 Optical Front End (OFE)

The figure below shows the block diagram of the optical front end.

Figure 5:
Optical Front End
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The optical front end consists of:

° 4 LED drivers, individually configurable, operated manually or controlled by the built-in sampling
sequencer

° 2 built-in green LEDs (VD1 and VD2)
° 1 built-in IR LED (VD4)
° 1 free for connecting an external LED to VD3

° 6 photodiodes

° 4 with green filters (PD1, PD2, PD3 and PD4)
° 1 with IR filter (B) (PD5)
° 1 Clear (A) (PD6)

Figure 6:
Photodiode Arrangement
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Trans-Impedance Amplifier (TIA)

° Configurable photodiode connection

° Photodiode input current offset compensation

° Configurable gain

° 2 different modes of operation — photocurrent to voltage converter or photocurrent integrator
° Clip detection

Figure 7:

Trans-Impedance Amplifier
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° TIA output filter (Prefilter, see Figure 8)

Adjustable anti-aliasing low-pass filter

Configurable high-pass filter to remove DC component
Adjustable gain stage

Clip detection

° 2 identical signal conditioning blocks (OFE1 and OFEZ2, see Figure 8)

° Synchronous demodulator — Used to extract small optical signals in noisy environment
(ambient light)

Adjustable synchronous demodulator output low pass filter

Adjustable high pass filter for DC component removal

50/60 Hz notch filter

Adjustable output gain stage

Adjustable low pass OFE1/2 output anti-aliasing filter (Figure 8)
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Figure 8:
Optical Signal Conditioning
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Each of the blocks depicted on Figure 8 can be individually enabled or disabled/bypassed.

4.2 ECG Amplifier

The ECG (electro cardiogram) amplifier is a high impedance, low noise instrumentation amplifier with
analog circuitry to band pass filter the signal. Gain is distributed between 3 gain stages. The gain in
the first stage determines the tradeoff between achievable noise level and achievable input offset
voltage. With the highest gain of 4 at the first gain stage (G1) about 400 mV of offset can be managed.
This value scales up to a max of 1.6 V of offset at gain 1. An optional 50/60 Hz notch filter can be
enabled to attenuate unwanted noise from mains coupling.

The recommended gain settings are 4-6-8 and 4-6-16
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Figure 9:
ECG Amplifier Circuit
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4.3 Electrical Analog Front End (EAFE)

The four general-purpose pins and ECG_REF can be used as analog input pins for the electrical
analog front end.

The analog inputs configuration sets up different non-inverting amplifier topologies:

With offset and input voltage divider (temperature sensor)

With current source and offset (temperature sensor)

With current source and reference path (temperature sensor)
With high impedance, GND referenced

With DC-Blocking, referenced to V_ADCRef/2

With DC-blocking and fast settling time, referenced to ADCRef /2

Figure 11:
Electrical Analog Front End
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4.4 Light-to-Frequency Converter (LTF)

The LTF module can use any of the photodiodes. Photodiodes connected to the LTF cannot be used
at the same time with TIA. Integration time (itime) is configured in unit steps, one unit step is 3.702 ms.
The unit step can be reduced by 2, 4 or 8, this also reduces the resolution of the conversion. The LTF
modulator can be set to run continuously and write the result of each integration to the FIFO.

Figure 12:
Light-to-Frequency Converter
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4.5 ADC and FIFO

45.1 ADC

The ADC is a 14-bit successive approximation register type with input clock of 1 MHz. A configurable
clock divider can reduce the input clock. One conversion takes 25 clock cycles plus configurable
number of ADC settling clock cycles (64 the default for ADC settling cycles).The ADC can be manually
triggered by register or automatically triggered by the built-in sampling sequencer. Two channel
selection registers ADC_CHANNEL_MASK L and ADC_CHANNEL_MASK_H define the channels the
ADC will convert. The ADC will start with the channels in ADC_CHANNEL MASK L from the LS
asserted bit to the MS asserted bit, then continue with the channels in ADC_CHANNEL_MASK_H
register again from LS asserted bit to MS asserted bit. Then wraps back to the LS bit of
ADC_CHANNEL_MASK_ L. Thus, the ADC will go through each channel in the order as shown in
Figure 13 with TIA being the first (smallest index), OFE1 second, SD1 third and so on to the GP102
being the last.
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When triggered from the sequencer, the channel selection is always set to the smallest channel when
the sequencer starts for the first time. When sequencer starts, then stops and starts again, channel
selection will not reset, it will stay at the channel it was on when the sequencer stopped.

When triggered manually, the channel selection resets with every write to one of the channel selection
registers.

After each conversion, the sample goes to the FIFO and the channel selection automatically advances
to the next enabled channel. The current ADC output is also available in the ADC data register, but as
there is no latch mechanism, the data from this register can be inconsistent as the ADC might be
running at the time of ADC data register access.

ADC can trigger an interrupt after conversion has finished.

Figure 13:
ADC Channels

Start fromtop and cyele through channels where vV LDO
adc_channel_mask_.. =1 (first channel selected seq_start 0-=1). -

ref=1.6V

A adc_channel_mask tia 4¥. ADC_DATAHIL
Tl adc_channel_mask_ofe1/ * i
¥¥ A sdijofe2/sd2 - i | ¥
" Pre- ore A ] AGND
Filter — ety r
T
TIA L L
% adc_channel_mask_temp _:, FiFo
é b erntries
GPIOs B9  Electrical adc_channel_mask afe Y.
_ _mask_ : |
ECce [B— Frontend 5
REF adc_channel _mask_pregain _:,. il
__.ade_channel mask ecoo ¥ { |
fomECS ade channel mask ecd ¥ | |
GPI03 R adc_channel_mask_gpio3 Y- '
GPIO2 B adc channel mask gpio2 ¥
45.2 FIFO

The AS7030B FIFO is 256 bytes long. ADC samples are 2 bytes each, which means, FIFO can hold
up to 128 samples. There is a FIFO length register, which indicates how much samples are currently
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available in the FIFO. The FIFO can send an interrupt when the number of available samples reaches
a certain configurable threshold.

4.6 Digital Interface

4.6.1 GPIO Pins

All four GPIO pins can be digitally controlled and can have pull up/down enabled. They can also be
used as analog input pins for the EAFE, GPIO2 and GPIO3 can additionally be used with the ADC.

4.6.2 Interrupts

An interrupt output pin INT is used to interrupt the host. Depending on the setting in register INTENAB
each of the interrupt source below can assert INT output pin (active low).

irqg_adc: End of ADC conversion

irg_sequencer: End of sequencer sequence reached.

irg_ltf: A light-to-frequency conversion is finished.

irg_adc_threshold: ADC threshold triggered

irg_fifothreshold: FIFO almost full (as defined in register fifo_threshold)

irg_fifooverflow: FIFO overflow (error condition, data is lost)

irq_clipdetect: TIA output and/or SD output exceeded threshold— see details in CLIPSTATUS
irg_led_supply_low: LED supply low comparator triggered

4.7 Sampling Sequencer

The sampling sequencer synchronizes the LED pulsing, the synchronous demodulator, the ADC and
the integrator times. The sequencer configuration sets the LED on and off times, synchronous
demodulator positive and negative multiplication times, the ADC start time and the integrator start and
stop times. The sequencer generates the 8-bit timings based on the 1 us input clock. The input clock
can be reduced with a configurable clock divider.

The sequencer executes measurement cycles with a period defined by Equation 1 where SEQ_PER
and SEQ_DIV are registers of AS7030B having values from 0 to 255 (see pages 50 and 51 in the
AS7030B datasheet):

Equation 1:
SEQ_PER = (SEQ_DIV + 1) = 1lus

SEQ_DIV holds the value of the 1 us input clock divider.

Demo Kit Manual « PUBLIC
UG000493 + v1-00 + 2020-Jun-25 63 | 17


http://www.ams.com/Document-Feedback
http://ams.com

Document Feedback AS7030B
AS7030B Overview

am

Within one sequencer cycle, the sequencer will:

° Switch on the LEDs at the specified LED start time and then switch them off at the LED stop

time.

° Start the positive and negative synchronous modulator multiplications at the specified start and
stop times for each operation

° Trigger a conversion of the currently selected ADC channel at the time specified by the ADC

start time. After the conversion has finished, ADC channel selection will advance the next
enabled ADC channel, which is measured during the next cycle that gives one ADC channel per
sequencer cycle. For the TIA channel, two additional ADC timings can be specified. That means
TIA can be measured up to 3 times within the same sequencer cycle:

° A 2" measurement will be done, if the value for “2" TIA” is specified (> 0) and is greater
than the one given in “15" plus the time needed for the ADC to finish one conversion.

° A 3" measurement will be done, if “3" TIA” value is specified (> 0) and is greater than the
one given in “2"TIA” plus the time needed for the ADC to finish one conversion.

° In the case of more than one TIA measurement within the same sequencer cycle, it is

important to make sure that the additional measurements can finish within the time of one
sequencer cycle.
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Figure 14:
Sequencer Block Diagram
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4.7.1 Sampling Rate and Subsampling

Throughout this document, sampling rate refers to the rate at which the sequencer produces samples
of the same ADC channel. This depends on the number of enabled ADC channels and on
configuration of the subsampling feature of the sequencer.

Subsampling is used when the application requires lower sample rates than what is possible with the
configured SEQ_PER and SEQ_DIV values, and with the number of enabled ADC channels. Lower
sample rate can also be achieved by setting SEQ_PER and SEQ_DIV to large enough values, but this
is not advisable as SEQ_DIV is multiplied to all the timings of the sequencer, thus the LED pulses will
become very long, which is probably not desired. SEQ_DIV should be kept relatively small for finer
resolution of the times.
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The register SEQ_CFG and SD_SUBS configure how subsampling will be executed:

° sd_subs field in SD_SUBS register defines if subsampling is enabled; when it is 0, no
subsampling is done — every sequencer cycle triggers an ADC measurement (Figure 15);
setting to N>0, enables subsampling and then for N sequencer cycles the sequencer will not
trigger the ADC, followed by one cycle with ADC conversion.

° sd_subs_always bit in SEQ_CFG register defines if all enabled ADC channels are subject to
subsampling. Using this only makes sense for more than one enabled ADC channel.

° sd_subs_always = 1: subsampling of all enabled ADC channels (Figure 16)
° sd_subs_always = 0: subsampling of the first enabled ADC channel only (Figure 17)

The following three figures below show how subsampling is executed by the sequencer. In all of them
ADC cycle means one ADC iteration through all the enabled channels.

@ Attention

ADC cycle is not the same as sequencer cycle. ADC_SEL is the ADC channel selection;
ADC_ACCESS is an ADC conversion of the currently selected ADC channel; taoc is the configured
ADC start time in the sequencer configuration; tsus is the sequencer period given by Equation 1.

In Figure 15 three ADC channels are enabled - 1 (OFEL), 6 (EAFE) and 11 (GPI02). No subsampling
enabled (sd_subs=0).

In Figure 16 three ADC channels are enabled — 0 (TIA), 4 (SD2) and 8 (ECGO). Subsampling is
enabled, every second sequencer cycle will trigger the ADC (sd_subs=2) and all enabled ADC
channels are subsampled.

In Figure 17 three ADC channels are enabled — 0 (TIA), 4 (SD2) and 8 (ECGO0). Subsampling is
enabled, every third sequencer cycle will trigger ADC (sd_subs=3) and only the first enabled ADC
channel is subsampled.
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Figure 15:
No Subsampling (sd_subs=0)
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Figure 16:

Subsampling of All Enabled ADC Channels (sd_subs=2 and sd_subs_always=1)
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Figure 17:
Subsampling of 1st Enabled ADC Channel Only (sd_subs=3 and sd_subs_always=0)
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5 Software Description

51 Software Architecture

Figure 18:
SW Modules

Firmware modules Client SW modules

AST03X Control Register Data
driver requests Map handler

Communication protocol handler

Application dispatcher

AST703X
PD Offset & icati
AS6200 a Low level B Communication
control
LIS2DH12 ‘ ‘ | UsB/CDC
ADS111X

The AS7030B evaluation software consists of firmware and client software (GUI). The firmware runs
on an ARM Cortex M4 MCU (STM32L476RETX), implements virtual COM port CDC interface for client
communication and vital sign detection applications. The client software displays raw data, algorithm
data and power consumption. Raw data can be logged and exported as .csv file for further analysis.
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51.1 Evaluation Firmware

Figure 19:
Firmware Modules

Firmware modules

Application dispatcher

PD Offset & N
Low level Communication
LED current |guf 2 1
sensor drivers protocol handler
control

AS703X

AS6200

LIS2DH12
UsSB/CDC

ADS111X

HAL Layer Code Generated by STMCubeMX

° I2C, USB, interrupt handling

Low Level Sensor Drivers

° AS7030B vital sign sensor driver
° LIS2DH12 accelerometer driver for motion compensation
° ADS111X ADC for current consumption measurement

Communication Protocol Handler

Receives and parses packets coming from the UART interface and based on the protocol type
forwards them to the application dispatcher or executes them immediately when packet is one of
read/write AS7030B register, get FW number. Packs the responses to the incoming requests (when
one is expected) and sends them to the CDC interface for transmission to the host.

PD Offset and LED Current Control Algorithm

When enabled, its task is to bring the PPG signal to a certain predefined quality (expressed in
minimum peak to peak value) whereby using as less LED current as possible. The algorithm uses the
output of the TIA and OFE1 channels.
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It will first check if offset compensation needs to be applied by comparing the averaged TIA to a high
and a low threshold (both fixed in FW, not configurable). If the value is below the low threshold, PD
offset is decreased. If it is above the high threshold and if the currently configured PD offset is < 238,
PD offset is increased, otherwise the LED current is decreased.

If the TIA signal is within the range defined by the low and high thresholds, the algorithm will check if
the amplitude of the OFEL1 signal is within certain limits defined by configurable minimum and
maximum. In case the calculated OFE amplitude is outside this range, if OFE1 amplitude is below the
defined minimum, LED current is increased,; if it is above the maximum, LED current is decreased.
The range within which the LED current is allowed to change is given by configurable minimum and
maximum.

After a change in PD offset and/or LED input current, the algorithm will not do the OFEL check for a
period of 1500 milliseconds (this is the period of a 40 BPM heartrate). The current minimum and
maximum values of the OFEL signal are being reset at a configurable interval.

Refer to chapter PD Offset and LED Current Control Configuration for details on how to configure and
use it.

Application Dispatcher

The application dispatcher is responsible for sending the application requests, received from the client
software to the relevant application for execution. The FW implements 3 types of applications — control
requests handler, raw data handler and vital sign algorithm handlers. Implemented vital sign algorithm
handlers are heart rate monitor (HRM), heart rate variability (HRV) and blood pressure monitor (BPM).

Control Requests Handler

Handles FW control requests like application selection, AGC configuration and measurement
start/stop.

Raw AS7030B Data Handler

Collects and stores raw AS7030B sample data in a data buffer and sends the buffered data to the
client upon request.

Vital Sign Application Handlers — HRM, HRV and BP App Handlers

Aggregates data needed by the relevant algorithm, runs the algorithm and handles data requests sent
from the client.
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51.2 Client Software

Figure 20:
Client Software Modules

Client SW modules

AST703X Control Register Data
driver requests Map handler

Communication protocol handler

Use/CDC

Serial COM Driver

Low-level UART communication driver — Open/close COM port connections, send and receive byte
streams to/from the UART interface.

Communication Protocol Handler

Implementation of the communication protocols exchanged between the client software and the FW.

AS7030B Driver

Driver code used for AS7030B configuration (register read/write).

Control Requests

FW control requests — Start/stop measurements, select/deselect algorithm and AGC configuration.

Register Map

Direct access to the complete register set of the AS7030B.
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Data Handler

Handles incoming data — Updates the relevant ADC channel plot and/or updates vital sign data fields
of the GUI.

5.2 Graphical User Interface

This section describes the Graphical User Interface (GUI) of the AS7030B Vital Sign Sensor
application. The application is designed to be used with AS7030B sensor series evaluation Kits.

0 Information

° User Guide Version - 1.0
° Valid for the following software version - AS703x Vital Sign Sensor v.1.0.16.1
° Supported hardware - AS7030B_Evalboard v1.0

° Download - Navigate to https://ams.com/as7030B#tab/tools and download the latest version.

521 Overview

Figure 21 shows the main window of the graphical user interface. To connect to the board the
connection control elements are used (1). The measured data is displayed in the main section of the
application (6). Additional information about current consumption and temperature is displayed in (9).
Calculated heart rate, calculated blood pressure, heart rate variability are displayed in (8).
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Figure 21:
AS7030B Vital Sign Sensor - Graphical User Interface
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5.2.2 Powering Up and Starting a Measurement

1. Connect the sensor board and the mainboard via the 10-pin Picoblade cable.
Connect the micro USB to USB cable to the mainboard and plug it into your computer.
The green power LED will turn ON as soon as the board is powered.

Start the client software.

o > 0N

Select the appropriate COM port name from the drop down box.
6. Click the connect button &

o) .
7. Connect button will change its icon to ¢~ upon successful connection.
8. The two status boxes on the bottom right side will turn green and show the FW number
currently flashed on the board.

Figure 22:
Starting a Measurement
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1. Select one of the built-in configuration presets
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2. Optionally check and change AS7030B settings. On the first startup after SW installation no
settings are loaded, after that the last used settings will be used.

3. To start a measurement with the current settings click on the Start button.

4. The green AS7030B LEDs will turn on, Start button’s caption will change to “Stop”

5. Hold the ECG INP and reference electrodes with pointer and middle finger of your left hand, put
the pointer finger of your right hand on the ECG INN electrode and the middle finger of your
right hand on the AS7030B to measure

6. The raw pulse and ECG data will be displayed in the GUI

7. The output of the algorithm will be displayed on the right hand side of the window. The numbers
in the curly brackets show how many seconds have passed since the last result different than
zero was reported. After five seconds of no new result, the values will time out and the content

of the fields will change to “--“.

Setting Up for Blood Pressure Measurement

Figure 23:

Running Blood Pressure Measurement
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The blood pressure measurement will give most accurate results with a personalized user profile. A
default user profile is used, if no custom profile exists. To create a new user profile, open menu
Settings and select “Open user data dialog”.

Figure 24:

User Data Window

EEwr com2
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File \View Help
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Log raw data

Apply 50Hz notch filter
Apply DC filter

Open user data dialog

LEDs
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Tia

OFE

Sequencer

ADC

Interrupts

ECG amphfier

Electrical analog frontend

@] User data

User name
Age

Height
Weight
Arterial length

Sex

Systolic reference
Diastolic reference
Systolic offset

Diastolic offset

Default User
50

188

80

108

® male female

120]

80

New  Calibrate

Set

In the “User data” window click on button “New”. The field “User name” will change to “New user” and

the “New” button will change its caption to “Save”. Enter all field values:

° Age — Age in years

° Height — In cm

° Weight — In kg

° Arterial length — In cm (0 = unknown); to measure the arterial length, please measure the
distance from the tip of your right middle finger to the middle of the line from your left nipple to
the left axle as shown in Figure 25. If the field is left zero, the arterial length will be estimated
based on the user’s height.

° Systolic and Diastolic reference - Obtained with a reference device (e.g. a cuff device)

° Systolic offset - Calculated during calibration, not enabled for user input

° Diastolic offset - Calculated during calibration, not enabled for user input
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Figure 25:
Measurement of the Arterial Length

Click “Save” to add the newly created user profile to the user profile database.

Figure 26:
Creating a New User

User data ? * User data ? >
User name MNew user User name Jane Doe

Age 50 Age 40

Height 183 Height 165

Weight a0 Weight 60

Arterial length 108 Arterial length 100

Sex & male female Sex male ® female

Systolic reference 0 Systolic reference 122

Diastolic reference 0 Diastolic reference 381

Systolic offzet 0 Systolic offzet 0

Diastolic offset 0 Diastolic offset 0

Save Calibrate Cancel Set Save Calibrate Cancel Set

Next step is to execute the calibration procedure in order to get the values for Systolic and Diastolic
offsets. This requires that the board is connected and the “BPM” configuration is selected from the
configuration presets. If not, click “Set” to close the “User data” window and go back to the “Main”
window (“Set” also sets the current user). Connect to the board, select the “BPM” preset and go back
to the “User data” window to execute the calibration procedure.
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Calibration Procedure

Select the user to calibrate from the “User name” combo box and click the “Calibrate” button. The
caption of the “Calibrate” button will change to “Calibrating...”.

Figure 27:
User Calibration

User data ? x User data ? x
User name Jane Doe User name Jane Doe
Jane Doe

Age i lohn Doe | Age 40
Height 165 Height 165
Weight 50 Weight 50
Arterial length 100 Avrterial length 100
Sex male & female Sex male & female
Systolic reference 122 Syetolic reference 122
Diastolic reference 81 Diastolic reference 81
Systolic offset 0 Systolic offzet 0
Diastolic offset 0 Diastolic offzet 0

New Calibrate: Cancel Set New Calibrating... Cancel Set

Blood pressure measurement will start. The “Start” button will turn to “Stop”, the PPG and ECG graphs
will start plotting the raw data, and blood pressure values will start displaying on the “Main” window.
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Figure 28:
Calibration Ongoing
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After calculating the five blood pressure values successfully, calibration will be finished, the
measurement is stopped and the values for “Systolic offset” and “Diastolic offset” are updated.
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Figure 29:
Calibration Finished

Y] User data ? >

=zer name Jane Doe =
Age 40

Height 165

Weight &0

Arterial length 100

Sex male ® female

Systolic reference 122
Diastolic reference &1
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Diastolic offset 1

MNew Calicrate Cancel Set

Click “Set” to save the values and close the window.
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524 AS7030B Configuration Settings

The AS7030B configuration settings are located on the left of the evaluation software (see Figure 21).
At power-up, the board starts with the following default configuration:

The two green LEDS - LED1(VD1) and LED2(VD2) are enabled, the LED current set to 1 mA
Sequencer period set to 2000 pus

Photodiode Trans-Impedance amplifier (TIA) is on and used

All filters are on and used

ADC is set to measure only the optical front end 1 after the gain stage (OFE1)

The individual settings of each of the AS7030B blocks can be viewed/changed in the dedicated
configuration sub menu. To enter the submenus press the corresponding button.

Figure 30: Figure 31:
Submenu Selection AS7030B Block Diagram. Highlighted Blocks are Configured in the
According Submenus.
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For further information, please refer to the AS7030B Datasheet
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@ Attention

LED current, LED mode and LED state can be set in the “LEDs configuration” window. It is

recommended to configure the current only when the output is not active as there is no latch
implemented to keep the 10 bits consistent.

The LED current can be set via sliders in a range of 0.7 -100 mA. Using the Boost option the LED
current can be doubled. The LEDx on option is only active in manual mode. In all other cases the

LEDs will be controlled by the logic.

The textbox LEDs current (mA) shown in Figure 32 allows to enter a numeric value for LED current

which will be set to all LEDs.

Figure 32:
LED Configuration Submenu

Figure 33:
LED Driver Block Diagram

LEDs Configuration
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Qutput current 786 uA  Qutput current
Boost Boost
Mode Mode
Controlied by sequencer Controlled by sequencer
Enable LED3 LED3 on Enable LED4 (ir)
Output current 785uA  Output current
Boost Boost
Wode Wode:
Always OFF Always OFF
+ Enable signal reference LED monttoring delay (ps) LEDs current (mA)
o8V o
0K

7

x

LEDZ on

786 uA

LED4 on
788 uA

Cancel

VD3 VD4
T ?“
D3| D4
ledX_supply [
O iow -
5.3 andirg_led_ —
= supply_low
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@ For further information, please refer to the following document:

° AS7030B Datasheet page 24 ff

Photodiodes Configuration

Select the photodiodes which are to be connected to TIA input. The offset current is optional, this
allows cancellation of constant light sources like sunlight. Default value for the input offset current is 0
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for both — LEDs off and any LED on. By default the offset is controlled by the PD offset control

algorithm accessible via menu 12.

For an external photodiode or any other sensor with (low) current output, the pins GPIO0 and GPIO1

can be used as input.

The sequencer controls the diodes — see DIODE_CTRL described in registe

r MAN_SEQ_CFG.

Figure 34: Figure 35:
Photodiode Configuration Submenu Photodiode Block Diagram
Photodiodes Configuration ? ot
any LED on?
+' Enable PD1 LED= on current offzet 0 nA @, pdoffx
+ Enable PD2 i —pdoffx_ledon
+ Enable PD3 ) —EE‘ pt’ |
+ Enable PD4 LEDs offion offset delta 0 n& _L—[>|—«—’u
W P2 L etoTiA
Enable GPIOD (PD_I0} 1t Bty (TransImpedance-Amplifier)
. ¥¥
Enable PD_B (PD_H) D
LEDs off current offset 0nA pd4
Boost GPIOD f———
| P pd_i0
2
B o—
Apply LEDs offion dekta = pd_i
T
oK Cancel

@ For further information, please refer to the following document:

° AS7030B Datasheet page. 35ff.

TIA (Trans-Impedance Amplifier) Configuration

The TIA has to be configured according to the information in the AS7030B datasheet (table in figure

33. AS703x Block Diagram).

It is recommended to keep the TIA settings at their default.
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Figure 37:
TIA Block Diagram
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For changing the TIA, stick to the following suggestions:

Figure 38:
TIA Suggestion

pd_ampcap

pd_ampcomp | pd_ampvo

pd_ampres pd1234®
1 1..4
2 1..4
3 1..4
1...2
4
3..4
1...2
5
3..4
1
6
2.4
1...2
7
3..4
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pd_ampres pd1234® pd_ampcap pd_ampcomp | pd_ampvo Gain
Low Bandwidth Mode
5 1...4 31 3 15 7 VInA

Integrating Mode (pd_ampres=0)

0 1.4 10 3 15 1 V/pQ
0 1.4 20 3 15 1/2 VIpQ
0 1.4 30 3 15 1/3 VIpQ

(2) pd1234 ... number of active photodiodes (for example, pd1=1, pd2=0, pd3=1, pd4=0 -> pd1234=2)

@ For further information, please refer to the following document:

° AS7030B Datasheet page. 40 ff.
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OFE (Optical Frontend) Configuration

In this window, the OFE blocks can be enabled and the filter chain is configured.

Figure 39:

OFE Configuration Submenu

Figure 40:
OFE Block Diagram
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HP fitter High OFE1 High OFE2
200Hz 1064mV 1084m\V
Gain
1
" Anti aliasing fitter is on Bypass anti aliasing fiter
v HP fiter is on Bypass HP fiter
" 5D gain stage is on Bypass SD gain stage
Bypass complete prefiter
oK Cancel
Optical Frentend Configuration ? x
+ OFE1 enable
OFE2 enable Prefiter OFE1 OFE2
+" Enable bias
+ Enable synchronous demedulator High pass fiter
Anti-aliasing frequency
+ Enable high pass fiter 0.33Hz
100kHz
+ Enable notch fiter SD low pass fitter
+ Enable gain stage 20Hz
Bypass synchronous demodulator Hoteh fiter
Bypass high pass fiter S0Hz
Bypass notch fiter Notch fiter bandwidth
Bypass gain stage 0
+ S0 negative infial polarity Gain
2
SD Hold
SO output forced to SIGREF
® 5D output is tristated
oK Cancel

aa_freq 12.5-200Hz gain_sd

_l Il

Prefitter

Synchronous Demodulator1,2 + BP Filter + Gain Stages

ofel/2_en ofe/2_sd_byp ofel/2_hp_byp_ecg notch_byp
From TIA — x ‘ F i ' i
-y ‘

ofel/2_sd_b l ofe1/2_hp_freq
ofel/2_hp_en

ofe_notch ofe1/2
_sel60 _gain_g

sd2 ofel

sd1

Clip Detf

=

Check OFEL1 and/or OFE2 check box to enable the corresponding OFE block.

To optimize signal quality adapt the OFE Gain setting to your application. The Bandwidth of HP and
LP can also be changed to suit your needs. The “SD negative initial polarity” switch will invert the

signal.

The “Prefilter” tab is used to configure the input filters of the two synchronous demodulators. For
reference, please see OFE_CFGA, OFE_CFGB, OFE_CFGC and OFE_CFGD register descriptions in
the AS7030B datasheet.
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@ For further information, please refer to the following document:

° AS7030B Datasheet page. 47 ff ...

Sequencer Configuration

Figure 41:
Sequencer Configuration Submenu

Sequencer Configuration ? X
+' Enable sequencer Ultra low power mode Activate manual mode Sync on GPIO
Sample rate Diode control Enabled ADC channels
Frequency (Hz) agp GPIOZ 502 before gain stage
PD1-=LED1; PD2-+LEDZ; PD3-=LED3; PD4-=LED4
Period (us) 4880 Electrical frontend " SD1 after gain stage
& FO1-PD4 connected " Tl& output ECG amplifier input
Sequencer cycles Temperature 502 after gain stage
Cycle period 166 PD1PD2->LED1; PD3,PD4->LED2 Pregain SD1 before gain stage
Clock divider 10 GPIO3 v ECG amplifier output
PD1,PD2-=LED1, PD3 PD4--LEDE
®  Run continuously LED driver Synchronous demodulator 1 Synchronous demodulator 2 ADC start time
Run f ber of cych
un for number ot eycies Primary LED timing Pogitive multiplication Positive multiplication 1st 1
Mumber of cycles 3 s s
Start time g Starttime g4 Start time ndTIA gy
Stop time g4 Stop time  1p4 Stop time W TIA 0
Subsampling Secondery LED timing Negative multiplication Negative multiplication Integrator
1st All Start time Start time 4 Start time Start time 4
Subsampling ratic 1 Stoptime g Stoptime  og Stoptime g Stop time g
oK Cancel

The “Cycle period” field of the “Sequencer configuration” window (see Figure 41) holds the value of
the SEQ_PER register. The client software will automatically calculate its value from the user input for
Sample frequency/period entered in the fields “Frequency (Hz)” / “Period (us)” of the “Sequencer
configuration” window (Figure 41). Sample period/frequency is the period/frequency between # of
samples of the same ADC channel and it depends on the number of enabled ADC channels. If the
calculation yields a value for the cycle period that is bigger than 255 - the maximum possible,
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subsampling will be enabled®. Please refer to Sampling Rate and Subsampling for details on sampling
rate.

Use this window to enable/disable ADC channels.

Any change in the values of the fields for sample frequency, sample period, cycle period and in the
ADC channel selection will cause a new calculation of the values for the rest of the fields.

@ For further information, please refer to the following document:

AS7030B Datasheet page. 47 ff.

ADC Configuration

This window configures the clock divider of the 1 MHz ADC input clock and the ADC settling periods.
ADC channels are enabled in the Sequencer Configuration window. The selection is shown below.

Figure 42: Figure 43:
ADC Configuration Submenu ADC Block Diagram
ADC Configuration ? X
Stant from top and cycle through channels where
| Enable ADC Threshoid 255 ads_channel_mask_. =1 (frst channel selected seq_mn':bn.,_ V—"D‘?mﬂ ™
Threshold differential Clock divider 2 = adc_chan net,mask,ua"'"‘ iy fan] ADC_DATAHIL
Threshold for TLA only Multimod ’ 5 W adc_channel_mask_ole1/
ultimode samples “ sdofedlsd2 — i |
Activate self calibration N = } oFe  [] LT ASHD
. Setfling time periods & o
" Power down when not converting TIA !
' Dizcharge capacitor before tracking H ’
ade_channel_mask_temp '__ FiFo
Muttimode e | Ghent
Enabled ADC channels GRIOs B Electrical adc_channel_mask_afe !,;
Sy demod 3 i " P ece_ & Frontend e
Synchronous demodulator 2 before gain stage Pregain GPIO2 REF ade channel mask pregain ".__
Synchronous demodulator 2 after gain stage Electrical frontend GPIO3 ,,,E!F:Fh?‘,lﬁ‘,—,!‘,‘:ﬁ!‘:@f?ﬁ,j—
Synchronous demodulator 1 before gain stage Temperature from ECG,,,E!E,E{‘E‘j'ﬂ,ﬂ?ﬁh_,ﬁeq,}PA
¥| Synchronous demodulator 1 after gain stage | v TlA output CPIIE adc_channel_mask_gpiod :‘__q
ECG amplifier input « | ECG amplifier output GRIOZE adc_channel mask gpio2 fkf
oK Cancel

1 For example, with one ADC channel enabled and desired sample rate of 200 Hz, the sequencer cycle period needs to be
5000 ps. If (SEQ_DIV+1) is 10, the SEQ_PER register should be 500, but as it is 8 bits, it cannot fit the value 500. It is also not
advisable to increase the clock divider as that will affect all the other timing settings, it is better to keep that small to give finer
granularity of the timing. To achieve the 200 Hz sample rate, the cycle period will be set to 250 and subsampling enabled with
subsampling ratio of 2 — meaning the ADC will be triggered every 2" sequencer cycle. That will give a sample rate of 200 Hz /
5000 ps period.
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@ For further information, please refer to the following document:

° AS7030B Datasheet page. 98 ff.

Interrupts Configuration

Enable interrupt sources:

° ADC: End of ADC conversion

° Sequencer: End of sequencer sequence reached.

° LTF: A light-to-frequency conversion is finished.

° ADC threshold: ADC threshold triggered — see ADC threshold.

° FIFO threshold: FIFO almost full (default is each sample triggers an interrupt)

° FIFO overflow: FIFO overflow (error condition, data is lost

° Clipdetect: TIA output and/or SD output exceeded threshold— see details in CLIPSTATUS
° LED supply low: LED supply low comparator triggered — see details in LEDSTATUS
Figure 44:

Interrupt Configuration Submenu

Dialeg

LED lowe supphy
Clipdetect
FIFC overflow

" FIFO threshold

oK

4 ot

ADC threshold
LTF

Seguencer

ADC

Cancel

@ For further information, please refer to the following document:

° AS7030B Datasheet page.109ff.

ECG Amplifier Configuration

The ECG (electro cardiogram) amplifier is a high impedance, low noise instrumentation amplifier with
analog circuitry to band pass filter the signal. Gain is distributed between 3 gain stages. The gain in
the first stage determines the tradeoff between achievable noise level and achievable input offset
voltage. With the highest gain of 4 at the first gain stage (G1) about 400 mV of offset can be managed.
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This value scales up to a max of 1.6 V of offset at gain 1. An optional 50/60 Hz notch filter can be
enabled to attenuate unwanted noise from mains coupling.

The recommended gain settings are 4-6-8 and 4-6-16.

The ECG signal can be used independently or together with PPG in further computation. (e.g. blood
pressure).

Figure 45:
ECG Amplifier Configuration Submenu

ECG Configuration ? >
' Enable ECG amplifier Signal reference
Fast startup 0.8V
Filter Leads detection
HP fitter frequency HP fiter mode Motch fiter frequency  LP fiter frequency Enable
0.33Hz Use Internal reference volkage S0Hz 160Hz Polarity
' Bypass notch fitter Sync to ADC
Gain stages Output thresholds
Input gain 1 Input gain 2 Cutput gain Low High Current
4 6 15 o o 20nA
oK Cancel
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Figure 46:
ECG Amplifier Block Diagram

ecg_low_leakage_en for diode leakage G ina=18
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@ For further information, please refer to the following document:
° AS7030B Datasheet page. 91ff.
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The electrical analog front end consists of three identical signal paths with independent settings of
bias condition, gain and offset.

Here the EAF_CFG, EAF_GST, EAF_BIAS, EAF_DAC and EAF_DAC_CFG registers are set.

Figure 47:

Electrical-Analog-Frontend Configuration

Submenu

Figure 48:
Electrical-Analog-Frontend Block Diagram

Electrical Analog Frontend Configuration X J— afe_enab_dac_buf
dac1_value __| ’ L
Enable dac2_value — DAC 5 .
DAC Gain stage sigref_un_dac_bmJ J . 1@
grio_dac ——y gpio_r_bias——a
Enable Enable afe_enab_dac o o
DAC buffer off Gain stage input T-?‘glf: e enf=| T?uits: —‘N =]
SIGREF to DAC buffer ECG_REF GPIOD
. GPIO1
DAC output to gain stage input Gain reference voltage g::gg '
DAC on GPID AGND ECG_REF T
MNo DAC biasing Gain e Tgates: afe_senab_gainstage
S050 Vref=1.6V
DAC value 1 DAC value 2 64 R o
000 0.00 measure_dac— \ 50k0 m“
: : Bias «——qst_gain ~7
Switch DAC values Mo 0.t AGND
Pyt N P esistor -gates -
Resistive biasing on ECG_REF resistance values are o 5
1-2-1-2-1-2-1-2-1-2-1-2- given as indication - don't | AGND 1 3..8x
rely on absdluts values SIGREF — 2. 4. 18
don't 2 T 5..32x
oK Cancel use  get ref gi“ :::'t -
@ For further information, please refer to the following document:
° AS7030B Datasheet page. 84ff.
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Light-to-Frequency Configuration

Light-to-frequency feature can be used to measure light input directly. Its main purpose is proximity
detection.

@ Attention

Do not use diodes that are connected to the TIA (register PD_A, PD_B, PD1...4) at the same time
when itf_en is enabled on the same diode.

For detailed information, please refer to the AS7030B datasheet.

Figure 49:
Light-to-Frequency Configuration
Submenu

Figure 50:
Light-to-Frequency Block Diagram

Light to Frequency Configuration ? 'Y

LTF enable
Integration time 3.072ms Integration time unit

A
MNormal, L5B=3.072ms 44

Continuous integration
Automatic autozero
Run in FIFO mode

Counter running

Channles OpAmp offset

Gain

025

Sensor diode for LTFO
A
Sensor diede for LTF1
A

Autozere channel 0

L.
] B 1>
¥¥.

conversion

Countsr

Itf_data0

Timer &
Capture

rﬁu—-
¥, JT

LTF D

¥¥

LTF 1

i

Itf_gain

itime:

16 bits

1tf_datat
16bis

Channel Channel 1 ti0_sel, Ift1_sel

0 0 Autozero channal 1

oK Cancel

The following registers can be shown/configured in the dialog: ITIME, LTF_CONFIG, LTF_SEL and
LTF_GAIN.

@ For further information, please refer to the following document:

° AS7030B Datasheet page. 73ff.

GPIOs Configuration

To set a GPIO to analog mode check the check box from the “GPIO mode” group box. If left
unchecked, then the GPIO is a digital output or input, depending on the state of the “GPIOx enable
output” check boxes - unchecked means the pin is digital input. If the pin is set as digital output, it's
state can be set via the corresponding check box in the “Output state” group box.
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Figure 51: Figure 52:
GPIO Configuration Submenu GIPO Block Diagram
GPIO Cenfiguration ? *x
GPIO mode Output state Pull up\down configurtion
~ GPIOD analog GPIOD output high GPIOD pull down enable VDD
~ GPIO1 analog GPIOT output high GPIO1 pull down enable
+ GPIO2 analbog GPIOZ output high GPI02 pull down enable —t gpio_o
+ GPIO3 analog GPIO3 output high GPIO3 pull down enable enabled if gpio_e=1
Slew rate GPIO0.. 3 —i t gpio_i
GPIOD enable cutput GPIOO Increased slew rate GPIOD pull up enable enabled ifgpio_a=0
GPIO1 enable output GPIO1 Increased slew rate GPIO1 pull up enable L—— o analog -
GPIO2 enable output GPRIO2 ncreased slew rate GPIOZ pull up enable
‘GPIO3 enable output ‘GPIO3 Increased slew rate ‘GPIO3 pull up enable
GND pullup/pulldown controlled
oK Cancel by gpio_p

@ For further information, please refer to the following document:

° AS7030B Datasheet page. 113ff.

5.25 Controller Configuration

This section describes the configurations of the firmware running on the microcontroller that
communicates with the AS7030B.

PD Offset and LED Current Control Configuration

The PD offset and LED current control is an algorithmic approach to increase signal quality of PPG
signals. The algorithm continuously monitors the TIA and OFEL outputs and if necessary reconfigures
the AS7030B while measuring to ensure ideal conditions.
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Figure 53:
PD Offset & LED Current Control Submenu

Dialog ? x
Minimum OFE1 signal amplitude 400
Maximum OFE1 =ignal amplitude 2000

Aweraging for TlA offset compensation 20
OFE1 min and max reset interval (ms) 2000

Minimum LED output current 1.17 m&

Maximum LED cutput current 5.93 ma

" Enable Tl& offset compensation

Enable OFE1 amplitude control

oK Cancel

Minimum OFE1 signal amplitude — If the amplitude of the OFE1 signal drops below that value, LED
current will be increased, if LED current control is enabled.

Maximum OFEL1 signal amplitude — If the amplitude of the OFE1 signal grows above that value, LED
current will be decreased, if LED current control is enabled.

Averaging for TIA offset compensation — How many samples are averaged before TIA mean value is
assessed based on which PD offset is corrected.

OFE1 min and max reset interval — The interval at which the min and max values are calculated over a
moving average are reset in order to keep a recent history and to avoid random spikes.

Minimum and maximum LED output current — Sets the range in which the LED current can move if
LED current control is enabled. If LED current control is disabled the LED have constant LED current
set in the LED Configuration window.

Enable TIA offset compensation and Enable OFE amplitude control — Check boxes define what will be
controlled by the algorithm and if the algorithm is enabled. If both checkboxes are unchecked, the
algorithm is disabled and there will be no correction for TIA offset and LED current control.

Enable TIA offset compensation check box: When checked, enables TIA offset compensation.

Enable OFE amplitude control check box: When checked, enables LED current control. LED current
control only works together with TIA offset compensation.
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5.2.6 Advanced Settings

Additional ADC Channels and Light-to-Frequency Data Display

The AS7030B Vital Sign Sensors evaluation software allows to display multiple channels. The PPG
and ECG channels are always active in the main windows. Additional channels can be displayed via
the View menu as shown in Figure 54

To display a data plot of an ADC channel other than OFE1 and ECG Output, click on menu “View >
ADC Channels” and then on the desired ADC channel.

For Light-to-Frequency data output, click on “View - LTF”.
A separate plot window will open.

Figure 54:
Additional Output Channels

AST03x Vital Signs Sensor
File WUETE Settings  Help
i: 1) Register Map |Bd 2
ADC Channels  » TIA
LTF Pregain
OFE1
AS702x settings so1 [
OFE2
LEDs D2
Photodiodes ECG input
ECG output
™ Electrical analog frontend
OFE GPIO2
GPIO3
Seauencer Temperature
ADC ) ——

Register Map

The “Register Map” window is used to view/change the contents of the complete set of AS7030B user
register. To open it, click on the “View > Register Map” menu.

Changing a register value can be done either by modifying its value in the relevant “Value” field or by
toggling a bit by clicking on the relevant bit cell. Changing a value in the register map will not update
the current selection in the configuration windows of the GUI. Also, a change in any of the
configuration windows will not trigger an automatic update of the already opened register map window.
To update the values, click on the refresh button marked with the orange rounded rectangle on the
“Register Map” picture on the right.
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Figure 55:
Register Map Dialog

Document Feedback

AS7030B

Software Description

Register Map
View

!

CONTROL

GPIO A

GPIO E

GPIO O

GPIO |

GPIO P

GPIO SR

GPIO T

GPIO SYMC
LED CFG

LED WAIT LOW
LED1 CURRL
LED1 CURRH
LEDZ2 CURRL
LEDZ2 CURRH
LED3 CURRL
LED3 CURRH
LED4 CURRL
LED4 CURRH
PD CFG
PDOFFX LEDOFF
PDOFFX LEDON
PD AMPRCCFG
PD AMPCFG

Addr.

i

Ox08
0x09
Ox0a
00k
0x0c
0x0d
0x0e
0x0f

0x10
0x11

0x12
0x13
Ox14
0x15
0x16
017
0x18
0x19
Ox1a
0x1b
xlc
Ox1d
e

[ R o R o R o [ o R o [ o [ e R e
[ I o R o IS o [ R o Y I o Y R R o R O R
=

[N e T o |
A o = R

= O O O = O

L B o TR s B N o (R

L == T = N e R =]

%]

[ I o R o [ o T e B R = B = e T )

N = B s B s R S

=

L= I . = B = I == I == L B == R == R

(=T S = [ o (Y R e |

=

Lo QR e R o [ o [ o Y e [ e B e Y e R R o R = R o R == L= IR =T == I == [ == R

amiun

Value

Demo Kit Manual « PUBLIC
UG000493 « v1-00 « 2020-Jun-25

Saving Current Configuration Settings to a File

The current configuration settings can be exported to a file. To do this, click on the “File > Save
Configuration” menu. This will open the “Save Configuration File” dialog box on the second picture on
the right. Enter file name and choose the file location, then click “Save”.
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Loading Configuration Settings from File

To load a previously exported configuration settings, click on the “File > Load Configuration” menu.
This will open the “Select Configuration File” dialog box. Select the configuration file from which to
load settings and click “Open” button.

The settings imported from the file can be reviewed in the relevant configuration windows.

If the GUI is connected to the board, the newly imported settings will be applied immediately,
otherwise upon successful connection to the board.

Figure 56:
Safe and Load Configuration
Menu Entries

Figure 57:
Safe Configuration File Dialog

01 Sove Configuration Fite %

AST03x Vital Signs Sensor

A« Program Files (86) » ams » AS7024 Vital Sign_Sensor > configurations ~|®| | Search configurations

A

NN View Seitings  Help Organize = Newfolder - @
A Name Size

Save Configuration & . -

File 1k

File ke

[] defautt
[ tast
[ prg.eca

Load Configuration
Export Raw Data

Save raw data and graphs

Exit

¢ softwarepool (\

= epol (\fsupdata
= public (\fsupva
LEDs = site (\fsupdata

Photodiodes

A A Fide Folders Cancel

Raw Data Logging and Exporting

By default, during measurement the raw data from the AS7030B is logged in memory. When a
measurement is stopped, this data can be exported to a comma delimited file by clicking on the
“File > Export Raw Data” menu and selecting the file location and file name in the save file dialog box.

Raw data file format:

° First raw has the column captions
° First column has the timestamp in milliseconds
° Columns 2" to the last have the data from the enabled ADC channels

Direct to file data logging can be enabled by checking the “Log raw data” check box in the “Settings”
menu.
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Figure 58: Figure 59:
Export Raw Data Menu Log Raw Data Menu
ASTD3x Vital Signs Sensor AS5TD3x Vital Signs Sensor
S View  Seftings Help File  View Help
Save Configuration o2 e comz Auto update
Load Configuration Config « Lograw data
Export Raw Data Apply 50Hz notch filter
Save raw data and graphs Apply DC filter
Exit AS7 Open user data dialog

5.2.7 Signal Optimization

Three settings have a major impact on signal strength and quality:

° LED current
° OFE gain
° Offset compensation

LED current has a direct impact on signal strength with minimal impact on noise. OFE gain will
increase overall signal strength but also increase noise. We recommend the following settings to begin
with and start experimenting from there:

Figure 60:
Useful Start Settings

Use Case LED Current [mA] OFE Gain
Finger 0.768 4

Light skin wrist 2 8

Dark skin wrist 5 16
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53 FW, Driver, API

5.3.1 Controller Firmware Update over USB

Starting in DFU Mode

In order to update the FW over USB on the AS7030B Evaluation Board the MCU has to be started in
DFU mode. To do so follow the steps below:

1. If the board is connected to the PC, disconnect it.

2, Press the button marked with yellow on the picture below and connect the USB cable to the
computer while keeping the button pressed. Release the button once the USB cable is plugged
in.

Figure 61:

Evaluation Board

AS7030

Rev.10

GPIO_UART2_RX
GPIO_UART2_TX
12C2_SCL
12C2_SDA
12C1_SDA

GND

v x
9“0
- D
o =
“ o
73

AS7030_GPIO
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3. Start the DfuSeDemo.exe from the “extras\DFU” folder located at the installation folder of the
GUI (if not changed during installation should be
“C:\Program Files (x86)\ams\AS703x_Vital_Sign_Sensor”).

Figure 62:
DfuSeDemo Started

¢ DfuSe Dermo (v3.0.5)

— >
Avalable DFU Devices
STH Device in DFL Mods | Application Mode: DFL Mode:
o VendoriD: | | VendorID: 0483
Supportz Upload b anifestation tolerant
Supports Download Accelerated Upload [ST] - Procuct 10 I:I Procuct |D; |DF11
LenDiezes Wersion: I:I Yerzion: | 2200
Enter DFU modesHID detach Leave DFU mode
Actions
Select Target(z]: ) .
Targetld  Mame Axailable Sectors [Double Click for more]
oo Internal Flazh 206 gectors...
m Option Bytes 2 zechars. ..
0z QTP temany 1 zectars...
Jpload Action Upagrade or “erify Action
File: File:
W — T argets in file:
Chooze... Upload Procuct 10

Transferred data zize Wersion:

0 EB[0 Bytes) of O KEB[D Bytes] (] Verity after download

[ ] Optimize Upgrade duration [Remove some FFs)

Operation duratian

000000 Upgrade Wl

Abart Cluit

° Click “Choose” to select the .dfu file containing the new FW and click on “Open”.
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Figure 63:
Choosing Firmware DFU Package

@ Open *
“ v P <« Local Disk (C:) » Program Files (x868) » ams » AST03x_Vital_Signs_Sensor » firmware (N Search firmware 2

Organize + MNew folder B o @

[ This PC ~ MName Date modified Type Size

) 3D Objects D as703x_fw_v1-0-3-5_md.dfu 10.10.2019 14:56 DFU File 82KB
[ Desktop

Documents

‘ Downloads

J5 Music

[&] Pictures

m Videos

‘i Local Disk (C:)

softwarepool (V\fsupdata) (5:)
gheh (\\fsupdata\usersSiaut) (U:)
public (Wfsupvault) (V2)

wsite (Vfsupdata) (X:)

CS5 (\Wsupdata\Team) (Z:)

v
File name: | as703x_fw_v1-0-3-5_md.dfu ~| | Dfu Files ¢*.dfu) v|
| Open | | Cancel |
° If the firmware was correctly loaded, the “Upgrade” button will be enabled, click on it to start the

upgrade process.
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Figure 64:
Firmware Correctly Loaded

g DfuSe Dermo (v3.0.3) — 4
Arvailable DF Devices
5TH Dievice in DFL Mode | Application Mode: DFL bode:
— Verdor ID: |:| Vendor ID: 0483
Supportz Upload b anifestation tolerant
Supportz Download Accelerated Upload [ST] Procuct 1D I:I Procuct |0 (DF11
Can Detach . .
Wersion: Yerzion: | 2200
Enter DFU mode/HID detach Leawe DFU mode I:I -
Actions
Select Target(z]: . .
Targetld  Hame Axwailable Sectors [Double Click for more]
Qo Internal Flazh 286 zectors...
01 Option Bytes 2 sectors...
0z QTP Memory 1 zectors...
IJpload Action Upgrade or Yerify Action
File: File: az703w_fw_v1-0-3-5_md. dfu
Vendar [0 (0483 Targets in file:
i 5T
Chooze... Upload Procuct [D: (0000

Tranzferred data size Yersion: | 0000

0 kB[O Bytez] of O KEB[D Bytes] [ Verity after downioad

] Optimize Upgrade duration [Femove some FFs)

O peration duratian

00:00:00 Upgrade Verity
File correctly loaded. |

Ahbort Cluit

° The pop-up window shown in the figure below will then open. Click on “Yes” to continue.
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Figure 65:

Document Feedback

Confirm Firmware Upgrade

AS7030B
Software Description

DfuseDemo

o Your device was plugged in DFU mode.

S50 itis impossible to make sure this file is correct for this
device,

Continue however 7
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Figure 66:
Firmware Upgrade Ongoing

g DfuSe Dermo (v3.0.3) — 4
Arvailable DF Devices
STH Dievice in DFL Mode Application Mode; DFL bode:
_ Verdor ID: D Vendor ID: 0483
Supportz Upload b anifestation tolerant
Supportz Download Accelerated Upload [ST] Procuct 1D I:I Procuct |0 (DF11
Can Detach . .
Yerzion: Yerzion: | 2200
Enter DFU mode/HID detach Leawe DFLU mode I:I -
Actions

Select Target(z]:

Targetld  Hame Axwailable Sectors [Double Click for more]
Internal Flazh 286 zectors
01 Option Bytes 2 sectors...
0z QTP Memory 1 zectors...
IJpload Action Upgrade or Yerify Action
File: File: az703w_fw_v1-0-3-5_md. dfu
Vendar [0 (0483 Targets in file:
i 5T
Chooze... Upload Procuct [D: (0000

Tranzferred data size Yersion: | 0000

O KB(D Bytes] of 30 KB[S2736 Bytes) [ Verity after downioad

] Optimize Upgrade duration [Femove some FFs)

O peration duratian
00: 00:02 Chooze. .. |lporade Werify

I]: Upgrading - Erase Phase [3324]...

Ahbort Cluit

° After the FW upgrade finished, click on “Leave DFU mode”, then “Quit”.
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Figure 67:
Firmware Upgrade Finished

g DfuSe Dermo (v3.0.3) — 4
Arvailable DF Devices
5TH Dievice in DFL Mode | Application Mode: DFL bode:
— Verdor ID: D Vendor ID: 0483
Supportz Upload b anifestation tolerant
Supportz Download Accelerated Upload [ST] Procuct 1D I:I Procuct |0 (DF11
Can Detach . .
Wersion: Yerzion: | 2200
Enter DFU mode/HID detach Leawe DFU mode I:I -
Actions
Select Target(z]: . .
Targetld  Hame Axwailable Sectors [Double Click for more]
Qo Internal Flazh 286 zectors...
01 Option Bytes 2 sectors...
0z QTP Memory 1 zectors...
IJpload Action Upgrade or Yerify Action
File: File: azf03m_fw_w1-0-3-5_md. dfu
Vendar [0 (0483 Targets in file:
i 5T
Chooze... Upload Procuct [D: (0000

Tranzferred data size Yersion: | 0000

20 KB[B2736 Butes) of 30 KB[B2736 )
Biytes) [ Werity after download

] Optimize Upgrade duration [Femove some FFs)

O peration duratian
00:00:14 Chooze. .. pagrade Werify

Target 00: Upgrade successful ! ‘

Ahbort Cluit

° You can now disconnect and reconnect the Mainboard and start using it in the GUI
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5) Revision Information

Changes from previous version to current revision v1-00

Initial version
° Page and figure numbers for the previous version may differ from page and figure numbers in the current revision.
° Correction of typographical errors is not explicitly mentioned.
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Copyrights & Disclaimer

Copyright ams AG, Tobelbader Strasse 30, 8141 Premstaetten, Austria-Europe. Trademarks Registered. All rights reserved.
The material herein may not be reproduced, adapted, merged, translated, stored, or used without the prior written consent of the
copyright owner.

Demo Kits, Evaluation Kits and Reference Designs are provided to recipient on an “as is” basis for demonstration and
evaluation purposes only and are not considered to be finished end-products intended and fit for general consumer use,
commercial applications and applications with special requirements such as but not limited to medical equipment or automotive
applications. Demo Kits, Evaluation Kits and Reference Designs have not been tested for compliance with electromagnetic
compatibility (EMC) standards and directives, unless otherwise specified. Demo Kits, Evaluation Kits and Reference Designs
shall be used by qualified personnel only.

ams AG reserves the right to change functionality and price of Demo Kits, Evaluation Kits and Reference Designs at any time
and without notice.

Any express or implied warranties, including, but not limited to the implied warranties of merchantability and fitness for a
particular purpose are disclaimed. Any claims and demands and any direct, indirect, incidental, special, exemplary or
consequential damages arising from the inadequacy of the provided Demo Kits, Evaluation Kits and Reference Designs or
incurred losses of any kind (e.g. loss of use, data or profits or business interruption however caused) as a consequence of their
use are excluded.

ams AG shall not be liable to recipient or any third party for any damages, including but not limited to personal injury, property
damage, loss of profits, loss of use, interruption of business or indirect, special, incidental or consequential damages, of any
kind, in connection with or arising out of the furnishing, performance or use of the technical data herein. No obligation or liability
to recipient or any third party shall arise or flow out of ams AG rendering of technical or other services.

RoHS Compliant & ams Green Statement

ROHS Compliant: The term RoHS compliant means that ams AG products fully comply with current RoHS directives. Our
semiconductor products do not contain any chemicals for all 6 substance categories plus additional 4 substance categories (per
amendment EU 2015/863), including the requirement that lead not exceed 0.1% by weight in homogeneous materials. Where
designed to be soldered at high temperatures, RoHS compliant products are suitable for use in specified lead-free processes.

ams Green (RoHS compliant and no Sbh/Br/Cl): ams Green defines that in addition to RoHS compliance, our products are free
of Bromine (Br) and Antimony (Sb) based flame retardants (Br or Sb do not exceed 0.1% by weight in homogeneous material)
and do not contain Chlorine (Cl not exceed 0.1% by weight in homogeneous material).

Important Information: The information provided in this statement represents ams AG knowledge and belief as of the date that
it is provided. ams AG bases its knowledge and belief on information provided by third parties, and makes no representation or
warranty as to the accuracy of such information. Efforts are underway to better integrate information from third parties. ams AG
has taken and continues to take reasonable steps to provide representative and accurate information but may not have
conducted destructive testing or chemical analysis on incoming materials and chemicals. ams AG and ams AG suppliers
consider certain information to be proprietary, and thus CAS numbers and other limited information may not be available for

release.

Headquarters Please visit our website at www.ams.com

ams AG Buy our products or get free samples online at www.ams.com/Products
Tobelbader Strasse 30 Technical Support is available at www.ams.com/Technical-Support

8141 Premstaetten Provide feedback about this document at www.ams.com/Document-Feedback
Austria, Europe For sales offices, distributors and representatives go to www.ams.com/Contact
Tel: +43 (0) 3136 500 0 For further information and requests, e-mail us at ams_sales@ams.com
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Mouser Electronics

Authorized Distributor

Click to View Pricing, Inventory, Delivery & Lifecycle Information:

ams OSRAM:
AS7030B-EVALKIT AS7030B_EVALKIT_USB



https://www.mouser.com/ams
https://www.mouser.com/access/?pn=AS7030B-EVALKIT
https://www.mouser.com/access/?pn=AS7030B_EVALKIT_USB
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